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This article has been obtained 
from APCUG with the author’s 
permission for publication by AP-
CUG member groups; all other 
uses require the permission of 
the author (see e-mail address 
above). 

If you've ever wondered how to 
bring email to the techno-phobe 
in your life, the answer isn't Ab-
racadabra, it's Presto. 

If you're reading this online, you 
own or have access to a computer. 
But you likely have friends or 
relatives -- perhaps elderly, 
budget-restricted, technophobic -- 
who don't. So they're not in close 
touch and can't share online fam-
ily or community activities. 

Presto <http://www.presto.com> 
is a combination color inkjet 
printer and paid Web-based ser-
vice which allows people without 
computers to receive email, in-
cluding attachments. 

Setting it up is simple: after pur-
chasing the device, someone with 
just a bit of tech savvy creates 
the account, picks an email ad-

dress (such as 
gabeg99@presto.com), and lists 
people allowed to send email to 
the address. At specified times of 
day, the printer dials a toll-free 
telephone number, downloads ac-
cumulated email, and prints it. 

With only two controls -- Volume 
and Stop -- it's easy to operate. It 
plugs directly into a telephone 
jack and doesn't need a separate 
phone line or jack or even a split-
ter, since an existing telephone or 
accessory (answering machine or 
Caller ID device) can plug into it, 
daisy-chain style. 

Presto is ideal for letting seniors 
receive email from children, 
grandchildren, friends, former 
colleagues, military buddies, etc. 
And it's useful when businesses 
request customer email addresses 
to conduct or simplify transac-
tions. It handles pictures and 
many attachment formats nicely, 
printing them as if it was a FAX 
machine.  
 

Magic Word Brings Email to the Offline World  
A review by Gabe Goldberg, 

 Computers and Publishing, Inc. 
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Board of Directors and Volunteer Staff Cyber Chat is published monthly by the 
ChautauquaCyber Club, Inc. It is distributed to 
each member and made available to the public 
through local business, educational, and public 
library organizations.  

The Chautauqua Cyber Club, Inc. is in no way 
responsible or liable for any damages resulting 
from articles, opinions, advertising 
representations, warranties expressed or 
implies in this publication. We do not endorse   
or recommend products or services. Comments 
or opinions do not necessarily reflect the 
policies of the Chautauqua Cyber Club, Inc. , 
Board of Directors. 

The principle of equal access/equal opportunity  
for everyone is practiced. 

The primary purpose is to assist our members 
and others to become more proficient in the use 
of a computer for their personal enjoyment. We 
serve through promotion of computer literacy 
and education by being actively involved in the 
community. 

The Chautauqua Cyber Club, Inc. is a not-for-
profit organization under section 501(c)3 for 
educational purposes, and incorporated under 
the laws of the State of Florida.   

CCC Listserv:  email to 
waltonccc@freelists.org 

Free computer help by using the club listserv. Post a problem by email and obtain an an-
swer (most of the time).   

The listserv is a service provided to members of the Chautauqua Cyber Club and invited 
guests. It is used for problems solving, posting club news and special bulletins, and to 
maintain a user friendly communication network. 

NOTICE 

Publishing information:  Articles submitted 
for publication should be in Microsoft Word or 
regular ASCII text and unformatted.  Photos 
with article are encouraged. 

Presenters/Writers:  Members are encour-
aged to volunteer and present a program on 
software or hardware. Vendors will provide 
presentations-in-a-box, and publishers will pro-
vide books for review. Whatever is presented 
becomes the property of the presenter. Make 
your interest known and share. You will be sur-
prised at what all is available to demonstrate. 

Cyber Chat:  This is a monthly publication. It 
is mailed to each members as a benefit, but can 
be viewed on the website at www.waltonccc.org.  

Donate Your Old Computer 

Help Promote Computer Literacy and Educa-
tion 

in Walton County 

Pentium  IV class computers 1.5 G, monitors, 
and printers in working condition are ac-

cepted 

Receipt issued upon request for tax credit 

Chautauqua Cyber Club, Inc.—      501(c)3 

To make a donation call  

    J. B. Hillard 892-3450 / 892-8100 
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March is upon us.  Time 
to do a bit of spring clean-
ing and get ready for sum-
mer.  Speaking of spring 
cleaning this would be a 
really good time for you to 
wipe off the vents to your 

computer and your monitor, for that 
matter any electronic equipment you 
have.  And you might as well clean out 
the dust bunnies from under the re-
frigerator and take the time to get the 
lint out of the dryer vent.  I know, I 
know, dusting is not my favorite thing 
either.  Kicks up my allergies and 
makes me miserable for the rest of the 
day, but one of those things that needs 
to be done.  Heat is the enemy to elec-
tronic goods so get that lint and dust 
cleared away before summer gets here.  
We had a really good meeting in Feb-
ruary.  I was surprised as to the num-
ber that were present.  I am hoping 
that everyone went home and started 
practicing their Facebook skills so you 
can bring on the questions at the 
meeting in March.  Next month, time 
permitting, I want to talk about Twit-
ter.  I am sure you are starting to see 
quite about twittering, tweets, tweeple 
and the such on the news as it is the 
current rage of the Web 2.0 world.  So 
get ready as I try to give you some of 

the ins and outs of how to use twitter 
at the next meeting.  I am finding all 
of this web 2.0 stuff pretty exciting as 
I learn to bring the various applica-
tions together so that one entry by my-
self, results in the information going to 
a wide variety of users all in the way 
that they desire to receive it.  To make 
this even easier, and to bring together 
a single location for news, computer 
information, things of that nature, I 
am working with Diane Merkel to do a 
complete overhaul of our website, 
waltonccc.org.  If curiosity is getting 
the best of you, feel free to track our 
progress as we work on the new site, 
you can watch it at 
waltonccc.southwalton.com.  Once we 
have most of the bugs and new fea-
tures installed, we will move it over to 
replace the current site with informa-
tion.  We also need some people that 
want to work on the new site.  Writers 
abound, so find something of interest 
that you are passionate about, let us 
know and we will set you up so that 
you can blog till your heart’s content.  
Well until next month……. 
 
Robert 

Roberts Ramblings 
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We had a really good meeting in February. 

We had twenty-one members in attendance.  
Three new members joined, they are Mariea 
Creamer, D.D. Karalec and Wayne Sconiers.  
We welcome them to the club to enjoy their 
membership and fellowship.  I think I may 
have misspelled DD’s last name, but I could 
not read my writing a few days after the 
meeting.  Sorry DD.   

Our fearless leader, Robert talked about the 
web site, Facebook.  He has set up a Group 
for us.  Just log into Facebook and search for 
Chautauqua Cyber Club.  He explained how 
you get friends to join your list and so on.  I 
don’t know about you but I ended up deleting 
my account.  Perhaps, I should give it an-
other go, as they say.  So, if anyone wants to 
start a Facebook account, I’ll be at the Senior 
Center on Wednesdays from 10:00 AM till 
Noon.  But, call Leigh at 892-8746 to make an 
appointment.  I had to do this because, I 
would go down there for a couple of weeks 
and nobody showed up.  No use in me sitting 
there waiting around for nothing.  Thus the 
call. 

If you want to try and do a Facebook Account, 
I shall be more than happy to help you.  Per-
haps we could both pick up a few things. 

Just to give you a heads up, in the near fu-
ture we will be closing the computer opera-
tion that we now have at the College and 
move it to the Life Enrichment Senior Cen-
ter.  As you know or may not know, JB is 
planning on retiring from the college and 

when  he does things at the college may 
change and the room that the Club has had 
for years may not be available to us in the fu-
ture.  Since the LESC has the room now, we 
might as well take advantage of it before the 
space is no longer available.  We will still 
have our meetings at the college.   

Sam and I have designated two rooms at the 
center for this purpose.  One all of the com-
puters that we presently have and maintain 
will be moved there.  The other room will be 
to work on computers as we are doing now.  
Except that members of the club and center 
can bring their computers in to have cleaned 
and maintained but not repaired. 

We have a volunteer that will build whatever 
is necessary to equip the new space.  Since 
this will fall under community projects this 
will entail using some Club funds for the 
building of this room.  This should not be sub-
stantial and if you know me, I don’t like to 
spend money I like to bring it in. 

More on this as we progress further. 

Now if you want an adventure here are some 
web sites that you can visit and download 
some really nice photos such as the first one: 

  

 apod.nasa.gov/apod 

 Tinyurl.com/37684 

 drawminos.com   

 pem.org/origami 

 hulu.com 

 oldcomputers.com 

 quotestumbler.com 

  

   Editor 

This ‘n that 
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___TIP LINE___ 
Q: 
Sometimes when I try to delete a file from 
my computer, it comes up with a "Cannot 
Delete File" error. Why does that happen 
and is there any way I can get around it? 
Please help! 

A: 
Worry no more! I can help, I can help! And be-
lieve me, I feel your pain. I often get that same 
error message and let me tell you, it ranks pretty 
high on my chart as one of the most frustrating 
things that could possibly happen with my com-
puter. And guessing by the tone of the question, 
I'm thinking several of you have had this prob-
lem too. 

Well, you've come to the right place, because I'm 
going to show you how you can actually get rid of 
the files your computer deems undeletable. Now, 
before I go on, I want to make sure everyone's on 
the same page. The "Cannot Delete File" error 
often shows up when you're trying to delete cer-
tain files off of your computer. It could be a docu-
ment or a picture, a music file or even a saved e-
mail. Whatever it is, for some reason, that error 
occurs more often than we'd all like. 

The error can pop up under several different cir-
cumstances as well. Sometimes the message may 
tell you it cannot delete the file because there's 
not enough free disk space. Other times, it will 
tell you another person or program is using the 
file and you have to close any applications that 
may be accessing it. Well, a lot of times, none of 
the scenarios make any sense. So, more often 
than not, you're left sitting there thinking, 
"What am I supposed to do now?" Well, here are 
some instructions on how to get past that pesky 
little error message. If you follow them exactly, 
the file you want to delete really will be deleted 
by the time you're finished. Here we go! 

1.) First, you need to find the location of the file 
you're trying to delete, as well as, the file's name. 
For example, maybe you're trying to delete a file 
called "mywork.txt" and it's located in your My 
Documents folder. (The location for that would 
then be C:\Documents and Settings\Your  

 

 

Name\My Documents. You must find the ex-
act and full location of the file for this to work). 
Write both of those down on a piece of paper and 
keep it close to you. 

2.) Next, go to Start, Turn Off Computer and 
choose Restart. 

3.) When your computer starts to boot back up, 
continuously hit the F8 key on your keyboard 
until the Advanced Boot Options Menu comes 
up. 

4.) From that menu, select the Safe Mode with 
Command Prompt choice and then log in nor-
mally to your local administrator account. 

5.) In the command prompt box, you're going to 
use the letters "cd" (it stands for change direc-
tory) with the location of the file you wrote down 
earlier. You'll also need to put quotation marks 
around the location. So, with my example from 
up above, you would type in cd "C:\Documents 
and Settings\Your Name\My Documents." 
You don't put quotes around the cd part, just the 
location. 

6.) The next command you need to type in is the 
delete command, which is "del." You'll need to do 
that with the file name you want to delete. With 
my example above, you would type in del my-
work.txt. You don't use quotation marks for this 
part. 

Once you have all that done, the file should be 
gone. You can go back to your initial location to 
make sure, but it should be deleted for good. If 
all goes well, you won't ever have to worry about 
that darn file again. This is just an easy way to 
get rid of all the files your computer tells you it 
cannot delete. You can't beat that feeling of hap-
piness, now can you?! 

~ Erin 

 

Reprinted with permission of Worldstart 
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Tech News That Affects Everybody 
Written by Sandy Berger, Com-

puKISS 
www.compukiss.com 

This article has been obtained from APCUG 
with the author’s permission for publication 
by APCUG member groups; all other uses re-
quire the permission of the author (see e-mail 
address above). 

Some of us scour the technology and business 
sections of the newspaper and the Web to get 
the latest news. Some of us head for the life-
style and community sections, without much 
of a care about technology. Yet, today's tech-
nology news is often news that will affect eve-
ryone's life in one way or another. 

Let me give you a few examples. The Pope 
recently announced opening of the Vatican 
YouTube channel (www.youtube.com/
vaticanit) which will feature short video clips 
of Pope Benedict XVI's activities and links to 
news and information about the Catholic 
Church. The Pope is posting two or three vid-
eos each day. Most are short clips showing 
the Pope's speeches, activities, and participa-
tion in important events. In a recent speech, 
the Pope praised the Internet as offering rich 
opportunities for dialogue, friendship and 
spreading the Christian message. 

There is a lot of irreverent stuff on YouTube, 
but the Pope's participation shows how main-
stream this popular video website has be-
come. YouTube, FaceBook, MySpace, and 
other social networking websites  have be-

come more and more popular. If you haven't 
yet visited any of these, YouTube is a great 
place to start. (www.youtube.com) 

Another recent news announcement was the 
Palm Pre, which is a smartphone that will be 
available in a few months through Sprint. 
You might think that this is just another 
phone, and you would be right. But the impli-
cations for cell phones are quite dramatic. 
Palm has developed a totally new version of 
the operating system for this phone. Google 
now has their own cell phone operating sys-
tem as do Microsoft, BlackBerry, and Apple. 
These are some pretty big name and you will 
notice that the software that runs these 
phones is called an operating system. That's 
because these phone are really mini-
computers that can do email, surf the web, 
and perform many other functions. Cell 
phones are changing dramatically. They are 
turning into handheld computers that will 
change the lives of those who use them. 

 We also should not overlook Apple's recent 
announcement that they will be dropping the 
DRM (digital rights management) for all 
songs in their iTunes store. The DRM crip-
pled the songs so they had limited use. For 
instance, they could only be played on a cer-
tain number of devices or be copied a certain 
number of times. So music lovers the world 
over will be rejoicing to see that by April of 
this year, all of iTunes 10 million songs will 
be DRM-free. There is one caveat. Those who 
have previously purchased music and/or vid-
eos on iTunes that included Apple's DRM will 
now have to pay to get the DRM removed. 
Apple will be charging 30 cents a song.  
iTunes has sold six billion songs since going 
online in 2003.  They did not offer any DRM-
free music until recently. So most of those six 
billion songs had DRM.   
 

   (See Tech page 8) 
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Font Size vs View Size - Image Size vs 
File Size 

 
Hal McCawley wrote to ask if there is a way 
to increase the font size on incoming Outlook 
Express and Windows Mail messages. Yes. 
Click on-
Tools>Options>Read>Fonts>Font Size 
and make your choice.  
I've also been asked about increasing the 
size of text found on Web pages. Internet Ex-
plorer 7 and 8 make this easy by having 
"percentage" choices in the lower right cor-
ner of all pages. Bear in mind that choosing 
a larger percentage only changes the 
"screen view" and not the size of an actual 
print-out on paper.  
However, if you're reading a North County 
Times webpage article 
(atwww.NCTimes.com) choosing an 
"Increase Font" option will increase both the 
view and the print-out size of the text.  
If you want a print-out of a particular arti-
cle, rather than the whole page, mouse-select 
the target text, right-click the selection, and 
click Print. In the dialogue box that appears 
checkmark "Selection" before clicking 
Print.  
For even more control over a print-out, con-
sider copying a Web page article or email 
message into a word processing program, 
where you can easily change font sizes, col-
ors, and styles along with any other editing 
you may want to insert. If your word proces-
sor is slow to launch, consider using Notepad 
for your print-out. Notepad is quick and 
easy, but limits you to one font and size, 
which can be chosen by clicking For-
mat>Font.  

Making a Digital Image Smaller — Di-
mensions or File Size?  

Other size issues concern images, where I'm 
often asked how to make a photo's size 
smaller. Well, this depends on whether one 
wants the physical dimensions of a picture 
smaller, such as, 4x6 inches instead of 9x12 
inches, or wants the "byte" size smaller so 
that the picture takes up less disk space.  
 
Well, I recommend Irfanview (free from 
www.Irfanview.com) to handle both these 
chores. When installing the application be 
sure to click "Yes" when asked if you want it 
to be your default program for opening and 
editing images. This will ensure that when 
an image's filename is double-clicked it will 
be displayed in Irfanview and be ready for 
physical resizing (which can include crop-
ping) and for "byte" resizing.  
 
If the picture is too large to fit comfortably in 
the Irfanview window, clicking the toolbar 
minus sign (-) will reduce it to a manageable 
size. To crop the picture, use your left mouse 
button to draw a box around the area you 
want to preserve. Then click the toolbar scis-
sors, followed by clicking the "Paste" icon. 
The cropped image will then appear for fur-
ther editing and/or being saved.  

To change a picture's physical dimensions 
click Image>Resize/Resample and type in 
the preferred width/height numbers or 
choose a percentage of the existing size.  
 
To change the byte-size of a JPG, click on 
File>Save As and give the picture a new 
name, whereupon the new file size will be 
approximately 80% of the original. However, 
this percentage of file compression can be 
adjusted to suit your particular needs.  

Printed with permission of Don Edring-
ton the Senior Tutor www.pcdon.com 

Computer Tutor Team Newsletter  
Feb. 28, 2009  

Don Edrington & Mary Hanson  
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   (Email from page 1) 

  

So it allows  sharing any online or computer 
content as PDF files such as maps and direc-
tions, travel itineraries, Web pages, spread-
sheets with financial or family contact infor-
mation. 

Simple steps authorize new people to send 
email, and when ink runs low, the printer is 
smart enough to either alert the person who 
set up the account or automatically order new 
cartridges. 

After failing for a dozen years to excite my in-
laws about email – they steadfastly resisted 
being online -- my retired Navy father-in-law 
fell in love with a Presto I loaned him, discov-
ering that it let him hear from his old Navy 
buddies around the world. And receiving 
color pictures of the grandchildren sealed the 
deal. 

The printer costs $150 or less (always com-
parison shop online!) and the service costs 
$12.50/month with yearly subscription. The 
only thing missing is the printer downloading 
paper and ink through the phone line -- but 
that would need real magic! 

This article first appeared on the Tiplet Web 
site, <www.tiplet.com> and is copyrighted by 
the author, Gabriel Goldberg. All rights are 
reserved; it may be reproduced, downloaded, 
or disseminated, for single use, or by non-
profit organizations for educational purposes, 
with attribution to Tiplet and the author. It 
should be unchanged and this paragraph 
must be included. Please e-mail the author at 
tiplet@gabegold.com when you use it, or for 
permission to excerpt or condense. Tiplet's 
free newsletter provides weekly computer 
tips. 
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If every purchaser pays Apple 30 cents for 
taking away the DRM, Apple would make 
$180,000,000. A boon to Apple, a pain-in-the-
rear for honest music lovers who previously 
used the iTunes store. 

Microsoft was also in the news recently with 
their announcement that the beta testing ver-
sion Windows 7, their next operating system 
could be downloaded and tried for free. Their 
website was inundated by curious Windows 
users. So many came, that they had to add 
more servers and download services. They 
originally said that they would limit the 
downloads to 2.5 million, but recently re-
moved that restriction and will continue to 
offer the beta trial until February. Don't 
think that you will be getting something for 
nothing, though. The beta of Windows 7 will 
stop being functional on August 1, 2009. At 
that time you will either have to reinstall 
your previous operating system or pay for 
Windows 7. 

Last but not least in the technology news is 
the announcement that Western Digital has 
created a 2 terabyte hard disk drive.  Believe 
it or not, this may have one of the biggest ef-
fects on individual users. As we can store 
more and more digital data at reasonable 
prices, more and more data will be digitized. 
We are already living in a digital world, but 
that world gets more reliant on technology 
every day. 

 

 

Do you know the punishment for bigamy? 

Two mothers-in-law! 
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Club Shirt 
Size, S, M, L, XL, 2X 

$15.00                                             

50% cotton 50% polyester 

Stain resistant 

Robert Connor— rcgold46@gmail.com 

 

 

 

A Career in Computing 
 

Main Campus  Chautauqua Center 
100 College Blvd  908 W. Hwy 90 

850-678-5111  850-892-8100 

Niceville, FL 32578  DeFuniak Springs, FL 32435 

I Fix Computers 

886 E. Baldwin Ave 

DeFuniak Springs, FL 32435 

850-892-0977 

www.defuniak.com 

Internet Service, dial-
up & high speed—full 

service home and 
business solutions 

Northwest Florida               
Association of Computer 

User Groups 
www.nwfacug.org 

Membership Application:   Chautauqua Cyber Club, Inc. 

Name:__________________________  Spouse:____________ 

Address:__________________________________ ZIP______ 

Telephone:____________ Email:________________________ 

Please check one:   [  ]  New [  ]  Renewal  [  ]  Family 

Membership is based on full 12 months 

Single and Family member-
ship are the same 

$22.00 per year 

$11.00 full time OWC        
students 
Chautauqua Cyber Club, Inc.                
P. O. Box 251, DeFuniak Springs, FL 
32435 



 

           

        STAMP 

 Membership renewal: 

It’s time to renew your membership if 
the date on your mailing label is:          
Mar 09 or before. 

CHAUTAUQUA CYBER CLUB, INC. 
P.O.  BOX 251 
DEFUNIAK SPRINGS, FL.  32435   

Affiliations 


